Zbirka pitanja za takmicenje talenata
za srednje skole prvi i drugi razred
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Uvod

Ova zbirka je namenjena pripremi za regionalno i republicko takmicenje
talentovane dece iz oblasti Informatika. Zbirka nema reSenja, ali do reSenja se
lako dolazi istrazivanjima na netu i/ili Citanjem udZbenika iz Informatike za
srednju Skolu. Ovo takmicenje se odnosni na talentovanu decu, a neka od njih
imaju pamcenje preko 90% procitanog, i ¢itaju brzinama od preko 400 reci u
minuti. Ovakvu materiju, oni, su sposobni da nauce napamet za manje od sat
vremena. Da bi izjednacili Sanse za uspesSnu izradu testa za svu decu koja
uCestvuju na ovom takmicenju i da bi ih motivisali da samostalno istrazuju po
internetu na zadate teme, ova zbiraka je bez datih reSenja. Dodatna prednost
ovog pristupa je mogucnost da deca tokom istrazivanja po internetu dodu do
ideja Sta joS mogu da rade u svojim projektima. [ako vecina pitanja premaSuje
ono Sto se radi u Skoli, treba imati na umu da je ovo takmicenje talentovane dece
iz oblasti informatika, a do sada smo imali prilike da se uverimo da je poznavanje
ove materije dece koja su zainteresovana za ovu oblast daleko ispred onoga Sto
se obraduje u Skoli.

Pitanja su podeljena u nekoliko osnovnih kategorija kao Sto su Opste racunarske
teme (operativni sistemi, arhitektura raCunara, komandna linija, mreZe, itd...),
teme vezane za web tehonologije i programiranje. Pitanja iz oblasti opstih



raCunarskih tema su takva da deca treba da imaju jedno solidno opste
raCunarsko obrazovanje kako bi uspesno na njih odgovorila. Odreden procenat
dece koji se aktivno bave ovom oblas¢u ¢e odgovoriti na ve¢inu ovih pitanja i bez
konsultovanja literature i interneta, dok ¢e ostali morati da se pomuce oko
pronalaZenja adekvatnih odgovora. Medutim u procesu pronalazenja odgovora
saznace joS$ interesantnih i korisnih informacija vezanih za date oblasti Sto ¢e im
koristiti ako se u budu¢nosti budu aktivno bavili oblas¢u Informatika.

Vecina radova dece na takmicenju talenata u zadnjih nekoliko godina su iz
sledecih oblasti: Web prezentacije, Jednostavnije Web aplikacije koristeci php i ]S
programiranje koriS¢enjem jave, C# ili VB. Primecena je tedencija da se sve viSe
dece opredeljuju za web aplikcije i prezentacije kao i povecano interesovanje za
mobilne, java i C# aplikacije. Iz ovog razloga akcenat u testovima je dat, pored
opstih raCunarskih tema, i na web tehnologije HTML, CSS, JS i php. Deca
zainteresovana za oblast informatka u srednjim Skolama se uglavnom bave
nekim oblikom programiranja iz tog razloga jedan deo nasih pitanja su iz oblasti
programiranja.

Na svako pitanje postoji samo jedan tacan odgovor. Vecina pitanja su preuzeta sa
predhodnih takmicenja a neka od njih su se prvi put pojavila u ovoj zbirci. Na
buducim takmicenjima oko 70% pitanja Ce biti iz ove zbirke, dok ¢e oko 30% biti
potpuno nova pitanja.

Takmicenje talentovane dece u oblasti Informatika

Takmicenje u oblasti informatike, talentovane dece se odrzava svake godine.
Prijava radova se vrsi do januara meseca, predaja radova do kraja aprila dok su
takmicenja u maju (regionalno) i junu (republicko). Takmicenje se sastoji iz dva
dela, u prvom delu se rade testovi opsSteg Informatickog obrazovanja, dok se u
drugom delu vrsi odbrana projekata-radova. Odbrana projekata se radi pred
komislijom od tri ¢lana. Clanovi komislije su proé¢itali sve radove pre takmicenja i
na samoj odbrani treba da ustanove u da li je takmicar samostalno radio rad i
kakvo mu je poznavanje materije iz koje je radio rad. Odbrana se sastoji od
prezentacije rezultata rada i ne bi trebalo da traje duZe od 15 min, nakon Cega
slede pitanja komislije. 50% poena se dobijaju iz rezultata testa opSteg
informaticarskog znanja a 50% kao ocena komisije. Osvojena mesta se racunaju
po ukupnom broju poena koji se osvoje.

Teme radova

Osim dela takmicenja sa pitanjima, glavni deo takmicenja je ipak pisanje nauc¢no-
strucnog rada, i prezentacija projekta i rada. Oblast Informatika je dosta
specificna, jer se deca samostalno dosta interesuju za ovu oblast i van onoga Sto
se radi u Skolama. Zbog toga na takmicenjima imamo vrlo raznolike radove na
raznim nivoima za isti uzrast. Primecena je tedencija interesovanja za izradu
web prezentacija i aplikacija, kao i za mobilne aplikacije. Takode ima sve viSe
dece koja poznaju javu, C# i druge napredne tehnike programiranja. Da bi se
izbeglo prepisivanje naucno-struc¢nih radova iz ove oblasti, kojih postoji jako
puno na netu, od dece se, uglavnom, oc¢ekuje da nesto konkretno i samostalno
kreiraju. Odnosno projekti u oblasti informatke su obi¢no praceni sa konkretnim
rezultatima, najceSc¢e u obliku programa, web prezentacije, i sl. Ponekad se
javljaju i radovi koji su uradeni kao projekat. Na primer, projekat Skolske mreZe,



projekat naplate preko bluetooth-a, robota podmornice, itd... Ve¢ina radova se
baziraju na demonstraciji dece da su savladali odredenu tehnologiju, ili ¢eSc¢e
skup tehnologija.

Pristup rada sa talentovanom decom treba da se zasniva na motivaciji dece da se
bave ovom oblas¢u viSe nego da se forsiraju ka postizanju rezultata, odnosno
osvajanja nekog mesta. Deca koja dodu u centar za telentovanu decu su na
razliCitim nivoima poznavanja Informacionih tehnologija, i tokom njihovog
bavljenja ovom oblas¢u oni dostiZu jedan visoki nivo poznavanja oblasti Sto je
vrlo dobra osnova za kasnija takmicenja i rezultate. Decu treba motivisati da
proucavaju Sto viSe razliCitih oblasti Informatike, i da pronadu $ta ih licno najvise
interesuje. PoZeljno je da su tokom osnovne Skole savladali web tehnologije
HTML, CSSi]S. U srednjoj Skoli bi bilo poZeljno da savladaju neki objektno
orijentisan programski jezik poput Jave ili C#-a. PHP je takode zgodan jer moZze
da se kombijuje sa poznavanjem klijentskih web tehnologija, u kreiranju nekog
sloZenijeg web projekta.

Pravila za izradu dokumenta rada
UBACITI SA CIRILICNOG FAJLA

Istorijat raCunarstva
1. Fransucki filozof, knjiZevnik, matematicar i fizicar Blez Paskal je napravio
oko 50-tak mehanickih modela maSina za objavljanje jednostavnih
matematickih operacija, pretece savremenih racunarskih masina. U kom
veku je Ziveo ovaj francuski naucnik?
a. XVI
b. XVII
c. XVIII
d. XIX
2. Masinu za racunanje “Paskalina” je konstruisao?
a. Charles Xavier Thomas.
b. Blaise Pascal.
c. Alan M Turing.
d. Grejs Hoper

3. Pomagalo za pamcenje brojeva pomocu kanapa se zvalo?

a. Quipu
b. Abakus

c. Paskalina
4. U kojoj tehnologiji su proizvedeni racunari prve generacije:
a. Tranzistori
b. Elektronske cevi
c. Integrisana kola
d. Visoko-integrisana kola
5. Prvi uspesno konstruisan rac¢unar je bio:
a. ABC
b. ENIAC
c. Blue Gene
d. EDVAC



6. Brzina promena tehnologija u oblasti hardvera moZe da se opise Moor-
ovim zakonom, koji kaZe da se kapacitet racunara povecava dva puta
svakih:

a. 18 meseca
b. 12 meseca
c. 3 meseca
d. 6 meseca
e. 36 meseca
7. IBM-ov PC racunar iz 1981 godine je koristio operativni sistem:

a. MSDOS
b. Windows
c. CP/M

d. BIOS

e. QDOS

Arhitektura racunara
Arhitektura racunara....

1. SIMM, DIMM, DDR i DDR2 su razliciti tipovi ¢ega?
a. Memorije koja se ugraduje u prenosne uredaje
b. Blokova RAM memorije.
c. HDD-a
d. Blokova ROM memorije.
2. Glavni nedostatk Hard Diska u odnosu na RAM Memorjiu
a. Kapacitet
b. Brzina pristupa
c. FiziCka veliCina
3. RAM je skracenica od
a. Read Access Memory
b. Random Access Memory
c. Read Advance Memory
d. Read Adaptive Memory
4. ROM je skracenica od?
a. Random Optimal Mask
b. Read Only Memory
c. Random Only Magnet
d. Regulating Optimal Memory
5. Vrsta memorije iz koje se podaci mogu samo Citati je:

a. ROM
b. EPROM
c. RAM

6. Skracenica DDR3 oznacva?
a. Double Date Rate
b. Double Disk Rate
c. Direct Disk Read
7. U koju vrstu memorija se svrstava page fajl?
a. radna memorija



b. keS memrija
c. virtualna memorija
d. spoljaSnja memorija
8. Memorija je deo racunar koji:
a. SluZi za trajno cuvanje procesiranih podataka
b. Upravlja radom ra¢unara
c. Sluzi za privremeno ¢uvanje procesiranih podataka
9. U koju vrstu memorija se svrstava BlueRay Disk?
a. radna memorija
b. keS memrija
c. virtualna memorija
d. spoljasnja memorija
10. Spoljne memorije spadaju u klasu:
a. ulazno-izlaznih uredaja
b. memorija koje ¢uvaju podatke samo dok ima napajanja
c. ROM memorija
d. RAM memorija
e. EPROM memorija
11. Spoljne memorije su one memorije:
a. Kojima se pristupa preko ulazno-izlaznih kanala (magistrala)
b. Koje se nalaze van kucista racunara
c. Koje se nalaze van procesora
d. Koje se nalaze na drugim racunarima
e. Kojima se pristupa preko sistemske magistrale.
12. Podaci na R-CD ROM diskovima se:
a. Ne mogu brisati
b. Mogu brisati neograniceno puta
c. Mogu brisati viSe puta
d. Mogu brisati samo jednom
e. Mogu brisati do 10000 puta
13. Skracenica ROM oznacava memorije koje imaju sledecu karakteristiku:
a. Cuvaju sadrzaj i kad nema napajanja
b. Cuvaju sadrZaj ako ima napajanja uz osvezZavanje svake
milisekunde
c. Cuvaju sadrzaj ako ima napajanja
d. Cuvaju sadrzaj ako ima napajanja uz povremeno osvezZavanje
e. Cuvaju sadrzaj i kad nema napajanja uz povremeno osvezavanje
14. Dinamicke memorije (DRAM) cuvaju sadrZaj:

a. samo dok ima napajanja strujom, ali je potrebno obnavljati sadrzaj
b. ikad nema napajanja strujom ali je potrebno obnavljati sadrzaj

c. samo dok ima napajanja strujom

d. ikada nema napajanja

e. nezavisno od napajanja

15. Staticke memorije (SRAM) cuvaju sadrzaj:

samo dok ima napajanja strujom

i kad nema napajanja strujom ali je potrebno obnavljati sadrzaj

i kada nema napajanja

nezavisno od napajanja

samo dok ima napajanja strujom, ali je potrebno obnavljati sadrzaj
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16. U koju vrstu memorija se svrstava DVD?
a. radna memorija
b. keS memrija
c. virtualna memorija
d. spoljaSnja memorija
17. Kapacitet DVD diskova je

a. veciod4 GB

b. izmedu 2561700 MB
c. izmedu 70011024 MB
d. 700 MB

e. manji od 256 MB

18. Koji od navedenih medijuma ima naveci kapacitet?
a. Flopy Disk

b. BD
c. DVD
d. CD
19. Na koji IRQ se obi¢no mapira LPT1 port:
a. 3
b. 5
c. 7
d 9
20. Rezolucija za HD od 1080p iznosi?
a. 1280x720

b. 1920x1080
c. 1600x1200
21.Rezolucija koja se obi¢no oznacava kao HD ready?

a. 1366x768
b. 1920x1080
c. 800x600

22.Film u HD 1080p formatu moZe da se smesti na koji medijum?
a. Blu Ray Disk
b. DVD
c. CD
23. Ako se za opis boje jedne tacCke digitalne fotografije koriste tri bajta, onda
se na fotografiji moze razaznati:
a. Preko 16 miliona boja

b. 256 boja
c. 8boja
d. 64635 boja
e. 16 boja
24.Koliko bitova ima jedan bajt
a. 4
b. 8
c. 16
d. 32
e. 64
25. Koliko bajtova ima 512 bitova
a. 8

b. 32



64
128
256
512
g. 1024
26. Koliko bajtova ima 1 MB?
a. 1.000.000
b. 1.048.576
c. 1.000.024
d. 1.024.024
27.1 GB sadrZi kolko Bajtova
a. 1073741824B
b. 1024B
c. 8B
28. Decimalna vrednost heksadecimalnog broja 10F je

o oan

a.
b.
C.

d.
e.

271
115
60

121
341

29. Decimalna vrednost heksadecimalnog broja 0AF je

a.
b.
C.
d.
e.

175
215
602
341
121

30. Decimalna vrednost binarnoh broja 101001 je

a.
b.
C.
d.
e.

41
60
3
115
12

31. Decimalna vrednost binarnog broja 011001 je

a.
b.
C.

d.
e.

25
12
3
115
60

32.Decimalna vrednost binarnog broja 001001 je

a. 9
b. 12
c. 115
d. 60
e. 3
33. Decimalna vrednost heksadecimalnog broja 101 je
257
34
115
12
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e. 60
34.Koja je osnova trinarnog brojnog sistema?

a. 3
b. 2
c. 0
d. 10
e. 8
35.Koja je osnova decimalnog brojnog sistema?
a. 10
b. 8
c. 2
d. 1
e. 0
36.Koja je osnova binarnog brojnog sistema?
a. 10
b. 0
c. 2
d. 16
e. 8
37.Sta je bit?

a. Jedna binarna cifra
b. Niz od osam bajtova
c. Niz od osam binarnih cifara
d. Memorijski prostor dovoljan za memorisanje jednog karaktera
e. Jedna heksadecimalna cifra
38. Brzina rada memorije se meri u?

a. GHz
b. FLIPS
c. MIPS
39. Brzina rada procesora se meri u?
a. GHz
b. FLIPS
c. MIPS
40. Procesor sa oznakom Q6600 je proizveden od strane kog proizvodaca?
a. Cyrix
b. AMD
c. Intel
41. Koji od navedenih procesora nije napravljen u AMD kompaniji?
a. Celeron
b. Opteron
c. Phenom
d. Athlon

42.Procesor E6700 pripada kojoj seriji procesora?
a. AMD Athlon
b. Quadro Core
c. Core2Duo
d. CoreSolo

43.Koji od navedenih uredaja jeste ulazni uredaj?
a. Monitor



b. Stampac
c. Game pad
44. Procesor sa oznakom Q6600 koliko ima jezgara?

a. 1
b. 2
c. 4
d. 8

45.U koju od navedenih kategorija spada procesor Intel Dual Core 2
a. 32 bitni, dvojezgarni
b. 64 bitni, dvojezgarni
c. 128 bitni, dvojezgarni
46.0znaka GeForce 8800GT oznacava koji deo u kompjuteru?
a. Mati¢nu plocu
b. HDD
c. Graficku karticu
d. Procesor
47. Matricni, laserski i kaplji¢ni (ink-jet) su vrste?

a. Skenera
b. Stampaca
c. Kamera

48. Kada se kaZe da je rezolucija Stampaca 600x600, onda to znaci da se
toliko tacaka moze odStampati na:
a. Jednoj strani
b. Jednom kvadratnom milimetru
c. Jednom kvadratnom centimetru
d. Jednom kvadratnom incu
49. Matricni Stampaci formiraju otisak:
a. udarom iglica na traku sa mastilom
b. prenosom boje sa unapred pripremljene matrice
c. nagorevanjem termickog papira
d. izbacivanjem kapljica mastila
e. rasporedivanjem grafitnog praha
50. Matricni Stampaci spadaju u klasu:
a. Stampaca sa udarom
b. laserskih Stampaca
c. TFT Stampaca
d. termickih Stampaca
e. ink-jet Stampaca
51. Ink-jet Stampaci formiraju otisak:
izbacivanjem kapljica mastila
udarom iglica na traku sa mastilom
prenosom boje sa unapred pripremljene matrice
nagorevanjem termickog papira
. rasporedivanjem grafitnog praha
52.Akoj ]e Stampac vezan na paralelni port raCunara, prilikom instalacije
Stampaca u dijalogu biramo sledeci port:
a. COM1
b. COM2
c. File
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d. LPT1
53. Koji od navedenih portova na raCunaru nije seriski?

a. COM
b. LPT
c. USB

54. Podaci u memoriji se beleZze pomoc¢u?
a. Nulaijedinica (ima napona, nema napona)
b. Razli¢itim nivoim napona struje (druk¢iji napon za svaku vrednost
koja se belezi)
c. Kvantnim stanjima atoma silicijuma u memoriskom modulu
55. Koja od navedenih rezolucija odgovara Sirokom ekranu?

a. 1440x900
b. 1024x768
c. 800x600
56. TFT (thin film transistor) tehnologija se koristi za proizvodnju:
a. Displeja

b. Cvrstih diskova
c. Procesora
d. Memorija
e. Magistrala
57.PCI Express magistrala moZe da ima:
a. 1,2,4,8,16ili 32 linije
b. Samo 8 linija
c. Samo 2 linije
d. Samo 16 linija
e. Samo 4 linije
58.GPU je?
a. Glavni Procesor
b. Cip na mati¢noj ploci
c. Procesor na grafickoj karti
59. U koju vrstu memorija se svrstava BlueRay?
a. radna memorija
b. keS memrija
c. virtualna memorija
d. spoljaSnja memorija
60. Brzina protoka podatak se meri u?
a. Bitovima po sekundi
b. Bitovima
c. Bajtovima po sekundi
d. Bajtovima
61. Protok podataka kroz modem se meri u?

a. bit/sec
b. byte/sec
c. clikc/sec
d. T/s

62. 0znaka na modemima 56kbps znaci
a. 56 kilo bita u sekundi
b. 56 kilo bajta u sekundi
c. 56 kikova brojaca po sekundi



d. Ovo niSta ne znaci
63. Sa protokom od 56 kbps za jednu sekundu moZemo da dovuc¢emo koliko

podataka
a. 7kB
b. 5,6 kB
c. 56kB
d. 1MB

64. WiMax predstavlja?
a. Nacin prenoSenja podataka putem telefonskog kabla
b. Nacin prenosSenja podataka putem mreZznog kabla
c. Nacin prenoSenja podataka putem radio talasa
65. Da li kontoler za Wii konzolu moZe da se poveze na Windows i kako?
a. Ne moze da se poveZe on je pravljen iskljucivo za Wii konzolu
b. MoZe preko USB kabla
c. Moze preko Bluetooth
d. Preko COM porta
66. Ulazni uredaji raCunara su
a. tastatura, mi$ i dZojstik
b. ekranitastatura
c. Ekran, tastatura i mis
d. EkraniStampac
67.Procesor i3 je napravila kompanija?

a. Apple
b. IBM
c. Intel
d. AMD
68. PC486 generacija racunara ima spoljni koprocesor?
a. DA
b. NE
69. Apple raCunar pod nazivom iPad ima koji procesor?
a. A4
b. i3
c. X2
d. G4
70. Cifre binarnog brojnog sistema su:
a. 0i2
b. 0,1i2
c. 0i1
71. Cifre oktalnog brojnog sistema su:
a. 0,1,2,34
b. 0,1,2,3

c. 0,1,2,3,4,5,6,7

72.CPU je deo raCunar koji:
a. Sluzi za trajno Cuvanje procesiranih podataka
b. Upravlja radom racunara

c. SluZziza privremeno ¢uvanje procesiranih podataka
73.



Operativni sistemi
- Windows (istorijat, delovi, arhitektura, apps)
- Linux (istorijat, delovi, ahritektura, apps)
- Mac OS X (istorijat, delovi, arhitktura, apps)

1. Operativni sistem spada u grupu:
a. Sistemskih programa
b. UsluZnih programa
c. Programa za akviziciju i upravljanje
d. Pomoc¢nih programa
e. Aplikativnih programa
2. U hijerarhijskom modelu operativnog sistema najniZi sloj se naziva
a. Low level system
b. Base
c. Jezgro
d. Interfejs
e. masinski kod
3. Iz Windows Explorera mogu da se krece kroz sledece
a. Samo kroz podatke na lokalnom disku
Kroz podatke na lokalnom disku i na spoljnjim diskovima
c. Kroz podatke na lokalnom disku, na spoljnjim diskovima, i kroz
lokalnu mrezu
d. Kroz podatke na lokalnom disku, na spoljnjim diskovima, kroz
lokalnu mrezu, i na internet
Windows Explorer je sistemski program koji se koristi za
PretraZivanje Interneta
Kreiranje i brisanje precica programa
Upravljanje podacima sa spoljasnih memorija racunara
4. Na Windows-u opcija “Save as...” ¢emo naci u stavci menija

=

a. Edit
b. Help
c. View
d. File

5. Dalije moguce notpad da se iskljuci, da ne bude instalran na Windows
operativnom sistemu.
a. Ne
b. Da
6. Koji od navedenih kodnih rasporeda predstavlja tipicnu univerzalnu
implementaciju Unicode kodnog rasporeda

a. CP1250
b. CP1251
c. UTF-8
d. ISO-8859-1
7. Koji od navedenih kodnih rasporeda moZe da prikaZe i latinicu i ¢irilicu
istovremeno?
a. CP1250
b. CP1251
c. UTF-8

d. ISO-8859-1



8. UNICODE kodira:
karaktere
b. bajtove
c. glifove
d
e

&

heksadecimalne brojeve
binarne brojeve
9. Koji od navedenih kodnih rasporeda predstavlja srpsku latinicu u

windowsu?
a. CP1250
b. CP1251
c. UTF-8
d. ISO-8859-1

10. Sta su to Unicode fontovi
a. Bilo koji font koji ima nasa latini¢na slova
b. Bilo koji font koji ima nasa ¢irili¢na slova
c. Fontovi koji nemaju nasa slova
d. Fontovi koji u sebi sadrZe skoro sve simbole svih jezika ukljucujuci
i naSu latinicu i ¢irilicu
11. Dali koli¢ina instaliranih fontova utic¢e na performanse Windows
operativnog sistema
a. Da
b. Ne
12. Oznaka SR u taskbaru za tastaturu oznacava?
a. Srpsku latini¢nu tastaturu
b. Srpsku ¢irilicnu tastaturu
c. Istaje oznaka i za srpsku latini¢nu i za srpsku ¢irilicnu
d. Srje oznaka za Sirijsku tastaturu
13. Da li se razlikuje raspored tastera na Srpskoj i Engleskoj tastaturi?
a. Da
b. Ne
c. Zavisi od proizvodaca
14. Cemu sluZi OLE objekat
a. Sluzi za vizuelnu raspodelu komponenti
b. SluZi za povezivanje programa sa bazom podataka
c. SluZziza ¢uvanje podataka iz drugih aplikacija
d. SluZziza definisanje programske strukture
15. Na Windows operativnom sistemu opcija “New” ¢emo naci u stavci menija

a. Edit

b. Help

c. View

d. File

16. Na Windows operativnom sistemu opcija ,Find“ se nalazi u kojoj stavci
menija?

a. File

b. Select

c. Edit

d. Help

17.Na Windows operativnom sistemu opcija ,Cut” se nalazi u kojoj stavci
menija?



a. File

b. Select

c. Edit

d. Help

18. Na Windows operativnom sistemu opcija ,Open” ¢emo naci u stavci
menija

a. Edit

b. Help

c. View

d. File

19. U okviru menija EDIT obi¢no se nalaze komande:
a. Cut, Copy i Paste
b. New, Openi Close
c. FontiParagraph
20. Koja precica na tastaturi je za @ kada je podeSena Srpska tastatura?
a. Shift+2
b. AltGr+V
c. Ctrl + Shift+ A
d. Nije moguce dobiti oznaku “@” ni jednom kombinacijom tastera.
21.Koja precica na tastaturi je za [ kada je podeSena Srpska tastatura?
a. Alt+S
b. AltGr+F
c. Ctrl + Shift+§
d. Nije moguce dobiti oznaku “[” ni jednom kombinacijom tastera.
22. Ako je na racunaru sa Windose 0S-om podeSena Srpska tastatura, kako
moZe da se otkuca “{“
Ctrl + Alt + S
AltGr +B
Ctrl + Shift + Alt + S
Nije moguce dobiti oznaku “{” ni jednom kombinacijom tastera na
srpskoj tastaturi.
23. Ako je na racunaru sa Windose 0S-om podeSena Srpska tastatura, kako
moZe da se otkuca “\“
a. Ctrl +Alt+\
b. AltGr+W
c. Ctrl+Alt+S
d. Nije moguce dobiti oznaku “\” ni jednom kombinacijom tastera na
srpskoj tastaturi.
24.Koja precica na Windowsu na tastaturi je za € kada je podeSena Srpska
tastatura?
a. Ctrl+Alt+E
b. AltGr+E
c. Ctrl + Shift + Alt+ E
d. Nije moguce dobiti oznaku “€” ni jednom kombinacijom tastera.
25. Windows Vista ima graficko okruZenje koje se zove?
a. Gnome
b. Aero
c. Windows
d. KDE
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26.Koji od navedenih nije graficko okruZenje Linux operativnog sistema?

a. KDE
b. Gnome
c. XFCE
d. Aero
27.Koje godine se pojavio prvi graficki operativni sistem?
a. 1984
b. 1988
c. 1990
d. 1994
28. Proizvodac opretivnog sistema Windows je:
a. DOS
b. Intel
c. Microsoft
d. IBM

29.U Control Panel-u koja ikona je zaduZena za menjanje slike na ekranu?
a. Regional Settings
b. Desktop Themes
c. Multimedia
d. Display
30. Promena tastature na srpsku se podeSava u okviru Control-Panela
izborom opcije:
a. Regional Settings

b. Display
c. System
d. Printers

31.Koja opcija se bira ako je potrebno poredjati datoteke u My Computer po
datumu poslednje izmene:
a. View->Arrange Icons by -> Size
b. View->Arrange Icons by -> Name
c. View->Details
d. View->Arrange Icons by -> Modified
32. Prilikom odabira vremenske zone, za nasu zemlju biramo?

a. GTM-2
b. GTM-1
c. GTM

d. GTM+1
e. GTM+2

33. Attribut Hidden, oznacava da datoteka:
a. MoZe samo da se Cita
b. Skrivena je pa ne moZe da se vidi pri listanju
c. Moze samo da se menja
d. Prebacena je u Recycle Bin
34. Osnovni format za zapis slika u programu Paint u Windows 7 je?

a. png
b. jpg
c. bmp

35. Office 2011 je Microsoftov proizvod namenjen?
a. Microsoft Vista operativnom sistemu



b. Microsoft Windows 7 operativnom sistemu
c. Linux Ubuntu 9.04 operativnom sistemu
d. Mac OS X operativnom sistemu
e. Microsoft ne poseduje proizod Office 2011
f. Preko COM porta
36. Format zapisa fajla u Word 2010 ima extenziju?
a. doc
b. *.docx
c. *odt
d. *xml

37.Koje od ovih aplikacija se isporucuju sa operativnim sistemom Windows
a. WordPad, Paint, Imaging
b. Word, Paint, Notpad
c. Notpad, Paint, WinCommander
d. Photoshop, Word, CorelDraw
38. Pomoc¢ u svakom programu moZe da se dobije odabirom:
a. F1 (tasterom)
b. Help (tasterom)
c. Any (tasterom)
d. Ctrl + H (kombinacijom tastera)
39. Na Windows operativnom sistemu kada se prevlaci ikona sa jednog
prozora na drugi a oba prozora pripadaju istom fizickom disku,
podrazumevana operacija je?

a. Copy
b. Move
c. Paste

d. Create Shortcuts Here
40. Clipboard ima veze sa slede¢im operacijama:

a. Cut, Copy i Paste

b. CutiDelete

c. Printi Print preview
41.Na Windows operativnhom sistemu Ako su nam ikone i tekst suviSe sitni

potrebno je?

a. Povecatirezoluciju ekrana

b. Smanjiti rezoluciju ekrana

c. Promena rezolucije ekrana nece uticati na velic¢inu teksta i ikona.
42.Program za obradu teksta koji dolazi u sklopu Windowsa je:

a. Word
b. WordPad
c. Outlook

43. Sta od navedenog nije 0S?

a. Wine
b. Mint
c. Slax
44. Ubuntu distribucija Linuxa je nastala od koje distribucije?
a. Debian
b. RedHat

c. Suse



d. Slackware
45. 0d sledecih imena samo jedno je ime operativnog sistema:

a. MacOSX
b. AMD
c. Internet Explorer
d. Intel
e. Apple
46.0d sledecih imena samo jedno je ime operativnog sistema:
a. Linux

b. Internet Explorer

c. OpenOffice

d. Intel

e. Word
47.Operativni sistem Linux se koristi
Za personalne (PC) racunare i servere
Samo za veb servere
Samo za servere
Samo za veb servere i mail servere
Samo za personalne (PC) racunare
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48.

Komandna linija

Upravljanje operativnim sistemom moZe da se sprovede na viSe razlicitih nacina.
Najuobicajenije je da se koriste razni alati specijalno napravljeni u tu svrhu,
medutim, ako Zelimo da zaista znamo kako da upravljamo operativim sistemom i
njegovim mogucnostima i delovima neophodno je da nau¢imo kako mozemo
direktno da pristupimo tim opcijama iz komandne linije, bez upotrebe alata.
Komandna linija je nac¢in da se obave operacije na operativnom sistemu
zadavanjem odgovarajucih naredbi i prosledivanjem parametara tim naredbama.
Interfejs komandne linije (CLI) je mehanizam za interakciju sa operativnim
sistemom ili nekim drugim softverom racunara uz pomocu niza tekstualnih
naredbi. Ona takode omogucava jednostavno udaljeno upravljanje operativnim
sistemom, bez potrebe za slozenom komunikacijuom (prikazivanje grafickog
okruzenja jednog sistema na drugom).

DOS

Windows operativni sistem je evoluirao od DOS operativnog sistema koji se
zasnivao na naredbama komandne linije. Osnovne operacije operativnog sistem
su se izdavale isklju¢ivo putem komandne linije. Sve aplikacije koje su radene za
DOS su imale odgovarajuce narebe koje su mogle da se pozovu iz komandne
linije. Nakon $to je kreirano graficko okruzenje (Windows 95), mnoge komande
DOS-a su izbacene ili zamenjene. Korisnici su u velikoj vecini izbacili upotrebu
komandne linije u novijim Windows desktop reSenjima. Medutim potreba za
razvijenim i bogatim skupom opcija u komandnoj lijniji je i dalje prisutna
pogotovo u serverskim verzijama. Iz tog razloga je u nekim novijim serverskim
verzijama operativnog sistem dodat veliki broj novih naredbi I mogu¢nosti, pa
cak i unapreden nacin rada sa komandnom linijom. Noviji Windows operativni



sistemi poput Windows 7 vrac¢aju mo¢ komandnoj liniji, mada u odnosu na Unix-
olike operativne sisteme Windows operativni sistem imaju znacajno slabije
razvijenu komandnu liniju, odnosno manje moguc¢nosti upravljanja operativnim
sistemom kroz komandnu liniju.

Windows PowerShell

PowerShell je jedna od najmoc¢nijih administratorskih alatki. Takozvana buduc¢a
zamena za command prompt. Baziran je na CL okruZenju a izgraden na .NET
tehnologiji. Predstavljen je kao alternative za script i batch zadatke. PowerShell
podrZava sve operativne sisteme, skripte i CL bazirane alate.

Posle pojave PowerShell-a sve se moZe napraviti preko komandne linije. Veoma
je zanimljivo i to da jednostavna komanda PowerShell-a ¢esto zamenjuje stranice
VB koda. Dosta je jednostavnija sintaksa. Exchange SystemManager inace u
pozadini izvrSava PowerShell komande, i time je reSen problem rada sa
skriptama u Windows okruZzenju. Stvari koje nije bilo moguce napraviti iz
komandne linije sada je moguce napraviti. Nema viSe problema oko VBScripta
koji je ranije zahtevao znanje programiranja, znanje Visual Basic-a, WMI-a,
WBEM-a, ADSI-a, objektnih modela... Naravno i reSen je problem sigurnosti.

Linux shell

Linux operativni sistemi imaju najrazvijeniji skup naredbi za upravljanje
operativnim sistemom iz komandne linije. Uz to moguce je pokrenuti operativni
sistem i bez grafickog okruZenja i sve u njemu obavljati iskljucivo pomoc¢u
naredbi komandne linije i/ili pomoc¢u napisanih skripti. Ovo je vrlo Cest slucaj sa
serverskim verzijama ovog operativnog sistema. Mnoge serverske verzije Linux
operativnog sistema se i isporucuju bez grafickog okruZenja. Linux je moguce
startovati i sa takozvanog Live CD-a pa onda experimentisati sa upravljanjem
nad operativnim sistemom bez naruSavanja bojazni da ¢e originalni operativni
sistem racunara biti ugrozen

Ovom segmentu se nalaze pitanja vezana za naredbe komandne linije dos-a,
power shell-a i linux-a.

1. Kako sadrzinu diska C kopiramo na disk D pomoc¢u DOS naredbe
DISKCOPY:
DISKCOPY C:D
DISKCOPY D:C
DISKCOPY CD
DISKCOPY D C
Ovu naredbu ne treba koristiti ni zasta drugo osim za kopiranja
disketa.
2. Koja od prikazanih DOS komandi kreira list.txt fajl i puni ga sa spiskom
fajlova iz tekuceg direktorijuma?
a. DIRlist.txt
b. DIR /flist.txt
c. DIR > list.txt
d. Nije moguce ispisati sadrZaj direktorijuma u fajl iz DOS naredbe
DIR.
3. Kako se formatira disk D iz dosa?
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10.

11.

12.

a. formatC:

b. format D:
c. f/D
d. formatD

Pomocu koje naredbe iz DOS-a moze da se prikaZu svi xml dokumenti u
teku¢em direktorijumu?

a. Dir xml

b. dir where doc=xml

c. dir *xml

d. dir extension=xml
Pomocu koje naredbe iz DOS-a moze da se prikaZu svi css dokumenti u
teku¢em direktorijumu?

a. Dircss
b. dir where doc=css
c. dir *.css

d. dir extension=css
Kopiranje podataka iz jednog foldera u drugi se vrSi pomoc¢u naredbe:
CP C:\folder\file1.ext c:\folder2
COPY C:\folder\filel.ext c:\folder2
CP C:\folder\filel.ext c:\folder2\filel.ext
COPY C:\folder\filel.ext c:\folder2\filelext
CP C:\folder\filel.ext c:\folder2\fileZ.ext

Dos naredba tree radi sledece:
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a. lIzlistavanje i pregled direktorijuma sa poddirektorijumima

b. Pravljvenje drveta direktorijuma
c. SmeStanje direktorijuma u poddirektorijum.

Pomocu koje dos naredbe se prazni ekran komandnog prompta?

a. Clear
b. CLS
c. EMPTY

U osnovne komande DOS-a ne spada:
a. New Folder

b. DIR

c. COPY

d. CD
Komanda DEL:

a. Daje pregled podataka o datotekama
b. Primema disketa ili disk za rad
c. BriSe datoteke
Koliko memorije je mogao da adresira DOS operativni sistem?

a. 1IMB

b. 2GB

c. 640kB

d. NeograniCeno



Koriséenje aplikacija (Word, Excel, Corel)
1. Kombinacija tastera u Wordu Ctrl + H oznacava

a. Find...

b. Replace...
c. Goto..

d. Hide..

2. Ako Zelimo u Wordu da selektujemo samo jednu recenicu to moZemo
uraditi na sledeci nacin
a. Kliknuti 3 puta miSem negde u recenici.
b. Kliknuti jednom miSem negde u recenici dok je pritisnut Ctrl
taster.
c. Kliknuti dva puta miSem negde u recenici dok je pritisnut Ctrl
taster.
d. Pozicionirati se ne pocCetak recenice i pritisnuti strelicu na desno
dok drzimo Ctrl, i Alt taster.
3. Kada se u Word-u pokazivac miSa nalazi na levoj ivici papira, tada se
jednim klikom na levi taster miSa selektuje:
a. Ceo tekst
b. Jednarecenica
c. Jedanred
d. Jedan pasus
4. Ako Zelite da u Word-u pretvorite sva slova u odgovarajuca velika slova
onda Cete, selektovati taj deo teksta pa:
a. Birate Edit->ToUpper
b. Birate Edit->All Caps
c. Birati View->All Caps
d. Birate Format->Font, pa potvrdite opciju All caps
5. Ako je neki deo teksta “italik” to znaci da je on:
a. Metalne boje
b. IskoSen
c. Podebljan
6. Ako je neki deo teksta “bold” to znaci da je on:
a. Metalne boje
b. IskoSen
c. Podebljan
7. Najpoznatiji program za obradu tabelarnih podataka je:
a. Word
b. Excel
c. Corel Draw
8. Pri kucanju teksta u Word-u, taster Enter se koristi za:
a. Prelazak u novired
b. Prelazak u novi pasus
c. Prelazak na novu stranu
9. U programu Word pomoc¢u koje kombinacije tastera moze da se selektuje
tekst od trenutnog poloZaja do kraja dokumenta
a. Ctrl + PgDown
b. Ctrl + Alt + Down
c. Ctrl + Shift + End
d. Ctrl + End



10. Ako Zelimo u Wordu da selektujemo samo jednu re¢ to moZemo uraditi na
sledeci nacin
a. Kliknuti 3 puta miSem negde u reci.
b. Kliknuti jednom miSem negde u reci dok je pritisnut Ctrl taster.
c. Kliknuti dva puta miSem negde u reci.
11. Ako u programu MS Word se aktivira kombinacija tastera Alt + I $ta Ce se
desiti?
a. Aktivirace se dijalog Insert
b. Ispisace se veliko slovo I
c. Aktivirace se meni Insert
d. NisSta se nece dogoditi
12.U programu Word pomocu koje kombinacije tastera moZe da se selektuje
tekst od trenutnog poloZaja do kraja reda
a. Shift + PgDown
b. Shift + Alt + Down
c. Ctrl + Shift + End
d. Shift+ End
13. Kojom kombinaciom tastera u Wordu moZemo da selektujemo kompletan
dokument?
a. Ctrl+D
b. Alt+D
c. AltGr+A
d. Ctrl+A
14. Ruler u Wordu moZe da pokazuje u in¢ima ili u mm od cega to zavisi?
a. 0d podeSavanja Windows sistema
b. 0d podeSavanja prilikom instalacije Worda.
c. 0Od podesavanja Worda.
d. Od podesavanja teku¢eg dokumenta.
15.U Wordu opcija “New” oznacava
a. Kreiranje novog dokumenta, pri ¢emu postojeci ostaje prisutan i
ne promenjen
b. Kreiranje novog dokumenta, pri cemu se postojeci automatski
snima i gasi.
c. Kreiranje novog dokumenta, pri cemu se postojeci samo gasi bez
snimanja.
d. Kreiranje novog dokumenta, pri ¢emu se korisniku postavlja
pitanje Sta da radi sa postoje¢im dokumentom.
16. Brisanje reda u Wordovoj tabeli se radi na slede¢i nacin (zaokruziti sve
tacne odgovore)
a. Selektovati ga iz menija edit odabrati Delete, u prozoru delite
odabrati dugme entire row
b. UCciniti aktivnim Celiju iz menija edit odabrati Delete, u prozoru
delite odabrati dugme entire row
c. Selektovatired i kliknuti na taster delete
d. Selektovatired i kliknuti na Backspace taster
17. Kombinacija tastera u Wordu Ctrl + A oznacava
a. Align
b. Select All
c. Auto format



d. Addrow
18. Ako Zelimo u Wordu da selektujemo sve do kraja reda odabrac¢emo
slede¢u kombinaciju tastera
Shift + PageDn
Shift + End
Shift + left
Ctrl + PageDn
Ctrl + End
Ctrl + left
Shift + Ctrl + PageDn
Shift + Ctrl + End
i.  Shift + Ctrl + left
19. Kombinacija tastera u Wordu Ctrl + Shift + End oznacava
a. Ne znadi niSta
b. Selektuje tekst do kraja reda
c. Pomera pokazivac na kraj reda
d. Selektuje tekst do kraja dokumenta
20.U programu Word pomocu tastera PageUp se pomeramo za:
a. Jedan list papira na gore
b. Jedno poglavlje na gore
c. Jedan ekranski prikaz na gore
d. Jednu sekciju na gore
21. PretraZivanje teksta u programima koji se bave tekstom se radi pomocu
precice:
a. F1 (tasterom)
b. Alt+F (tasterom)
c. F10 (tasterom)
d. Ctrl + F (kombinacijom tastera)
22.U programu Excel, funkcjaa koja izracunava prosecnu vrednost brojeva
koji se nalaze u odabranim c¢elijama je:
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a. SUM
b. AVERAGE
c. PRODUCT

23.U programu Excel otvaranjem menija Insert->Chart pokrece se:
a. Crtanje specijalnih simbola
b. Crtanje geometrijskih figura
c. Crtanje grafikona
24.Kako u Excel-u da izraCunamo srednju vrednost za polja izmedu A3 i A17
pri ¢emu se ta polja nalaze na drugom radnom listu (Sheet2)
Sheet2!AVERAGE(A3:A17)
AVERAGE(A3:A17)->Sheet2
AVERAGE(Sheet!A3:Sheet!A17)
Nije moguce izraCunati srednju vrednost iz vrednosti sa drugog
radnog lista
25. Treba da kreiramo niz podataka u C koloni koji se dobija tako Sto se
podaci iz B kolone od reda 3 do reda 18 mnoZe sa brojem u ¢eliji A2. Kako
izgleda formula u ¢eliji C3 koju moZemo posle da kopiramo u ostale celije?
a. A1*B3
b. A1*$B3
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c. $A$1*B3
d. A$1*B$3
26. Ako tekst koji se nalazi u Celiji A1 radnog lista Sheet1 Zelimo da
prikaZemo u Celiji radnog lista Sheet?2 ali sa sve velikim slovima. To mozZe
da se uradi na sledec¢i nacin.
a. Sheetl!Al
b. =BigChar(A1!Sheetl)
c. =Upper(A1l!Sheetl)
d. =Up(A1!Sheetl)
e. Nije moguce se pozivati na podatke sa drugih radnih listova.
27.Koja od navedenih formula nam obezbeduje slede¢e ponaSanje. Ako je
podatak na polju E18 D onda treba u Celiji da stoji vrednost iz polja G18 a
ako ne u polju treba da stoji suma podataka od celije F1 do celije F18
a. IF(E18="D",G18,SUM(F1:F18))
b. IF (E18="D") THEN (G18) ELSE (SUM(F1:F18))
c. IF(E18="D";G18;SUM(F1:F18))
28.Koja od navedenih formula nam obezbeduje slede¢e ponaSanje. Ako je
podatak na Al vec¢i od 10 onda treba cCelija da ostane prazna a ako
podatak nije veci od 10 onda u polju treba da stoji taj podatak.
a. IF(A1<10,"",A1)
b. IF (A1<10) THEN ("") ELSE (A1)
c. IF(A1>10;"";A1)
29. Koliko formula moZemo da ugnjezdavamo (ubacujemo jednu u drugu) u
Excelu iz paketa Office 2000

a. 5
b. 7
c. 9
d. 32

e. Nije ograniceno
30. Kako u Excel-u da izraCunamo sumu vrednost za polja izmedu A3 i A17
pri ¢emu se ta polja nalaze na drugom radnom listu (Sheet2)
a. Sheet2!SUM(A3:A17)
b. SUM(A3:A17)->Sheet2
c. SUM(Sheet2!A3:Sheet2!A17)
d. Nije moguce izracunati sumu vrednost za vrednosti sa drugog
radnog lista
31.Imamo u ¢eliji C1 vrednost evra. U koloni A od polja 3 imamo vrednosti u
dinarima. U koloni B od polja 3 treba da imamo vrednosti u €. Formula
koju ¢emo kopirati posle u sve ostale Celije kolone B a kreiracemo u celiji
B3 Ce izgledati?
a. A3*C1
b. A3*$C1
c. A3/$C$1
d. A3/C1
e. A3/$C1
32. Excel: Ako je potrebno u okviru izraza neku vrednost, na primer C2
fiksirati, onda ¢e na u izrazu biti definisana sa?
a. C2
b. $C2



c. $C$2
d. C$2
e. C$2%

33. Ako imamo podatak u polju A5 (odnos koeficijenta plate i bodova) i
Zelimo da sva polja u koloni C od reda 2 do reda 58 izracunaju vrednost u
plate a u koloni B imamo vrednost bodova od reda 2 do reda 58 to
moZemo da postignemo tako Sto ¢emo formulu da napiSemo u prvu cCeliju
C2 i onda ¢emo samo (markerom) da prevucemo preko ostalih ¢elija do
C58. Formula u polju C2 ¢e glasiti:

a. A5*B2
b. A5*$B2
c. $A$5*B2

d. A$5*B$2
34.Koja od navedenih formula nam obezbeduje slede¢e ponaSanje. Ako je
podatak na polju E18 “Da” onda treba u ¢eliji da stoji vrednost “PoloZio” a
ako podatak nije “Da” u polju treba da stoji “Pao”
a. IF(E18="Da","Polozio”,"Pao”)
b. IF (E18="Da") THEN (“PoloZio”) ELSE (“Pao”)
c. IF(E18="Da";“PoloZio“;“Pao“)
35.Koja od navedenih formula nam obezbeduje slede¢e ponaSanje. Ako je
podatak na polju J10 “Ispravan” onda treba u Celiji da stoji vrednost
“Ispravan” a ako podatak nije “Ispravan” u polju treba da stoji “Nije
ispravan”
a. IF(J10="Ispravan",”Ispravan”,”Nije ispravan”)
b. IF (J10="Ispravan") THEN (“Ispravan”) ELSE (“Nije ispravan”)
c. IF(J10="Ispravan";“Ispravan®;“Nije ispravan®)
36. Sta se desava ako u nekoj ¢eliji u kojoj izra¢unavamo rezultat neke
formule ne moze rezultat da stane u Celiju (vedi je od Sitine Celije)
a. Bice prikazan samo onaj deo rezultata koji moZe da stane
b. Bice prikazana poruka o greSci (Error...)
c. U celiji ¢e bit umesto brojeva ispisani ######
d. Celija ¢e biti prazna
37.Ako Zelimo da prikaZemo podatak koji se nalazi u radnom listu Sheetl u
¢eliji A3 u okviru druge Celije na taj podatak moZemo da se pozovemo na
sledeci nacin

a. Sheet1!A3
b. A3!Sheetl
c. Sheetl:A3

d. Nije moguce se pozivati na podatke sa drugih radnih listova.
38. Ako podesite da je format za prikazivanje datum dd/MM/yy onda Ce se
datum (29. Maj 2011) prikazati kao:

a. 05/29/11
b. 11/05/29
c. 29/05/11
d. 29/11/05

39. Excel: Ako imamo u ¢elijama od A1 do A24 brojeve od 1 do 24 $ta Ce da
nam vrati funkcija =COUNTIF(A1:A24,">10")



a. 24
b. Gresku
c. 14
d. 10
40. Ako imamo sledec¢u Excel tabelu
A B
1 20 10
2 10 15
3 20 20
4 30 25
5 20 30

i treba da saberemo sve brojeve iz kolone B kada u koloni A imamo broj
20. To ¢emo postici sa sledecom formulom?

a. =Sumlf(A2:A6, 20, C2:C6)
b. =Countlf(C2:C6, 20)
c. =Sum(A2:A6, 20, C2:C6)
d. =If(A2:A6, 20, C2:C6)
41.U Excel-u zaSta se koristi uslovno formatiranje?
a. Da bi se drukcije formatirale Celije koje ispunjavaju neki uslov
b. Ne postoji ovakva opcija u Excelu
c. Zakreiranje vizuelno atraktivnih grafikona
42.Pomocu koje precice se u Windows Exploreru prelazi u roditeljski

direktorijum
a. Ctrl + Back
b. Back
c. Up (strelCica na gore)
d. PageUp

43. OsveZavanje prikaza Windows Explorera se radi pomoc¢u?
a. F5 (tastera)
b. Ctrl + R (kombinacije tastera)
c. Ctrl + C (kombinacije tastera)
d. F2 (tastera)
44. Times New Roman spada u grupu? (zaokruziti sve tatne odgovore)
a. Serifni proporcionalni font
b. Neproporcionalni font
c. Ne serifni ne proporcionalni font
45. Cemu sluZi program Scan Disk
a. Defragmentaciji hard diksa
b. Formatira disk
c. Proveravanju ispravnost strukutre foldera i fajlova
d. Skenira disk u potrazi za konkretnim dokumentom
46.Koji program za obradu rasterskih slika dolazi sa operativnim sistemom
Windows XP?
a. Draw
b. Paint



c. PhotoShop

d. GIMP
47.Koji je najpoznatiji besplatni-OpenSource program za obradu rasterskih
slika?
a. Paint
b. ACDSee
c. GIMP

d. PhotoShop
48. Aplikacija GIMP je OpenSource besplatno reSenje koje moZe da zameni?
a. Word
b. PowerPoint
c. WinCommander
d. CorelDraw
e. Photoshop
49. Power Point 2010 ima extenziju

a. ppt
b. pot
C. pptx
d. odp
50. Aplikacija Power Point je deo kog paketa programa
a. MS Office
b. MS Visual Studio
c. Adobe CS
d. iWorks
51. Power Point template ima extenziju
a. otp
b. pot
c. ppt
d. odp

52. Open Office zamena za Microsoft PowerPoint se zove?
a. Presentation
b. Show Presentation
c. Drawing
d. Keynote
53. Aplikacija AutoCad je namenjena?
a. Radu sa 3D modelima
b. Radu sa Vektorskom grafikom
c. Radu sarasterskom grafikom
d. Radu sa fontovima

54. Web pretrazivac¢ kompanije Google se zove?

a. Chrome
b. Safari
c. GOS

d. Google Browser

55.Za obradu fotografija koristi se program:
a. Adobe Photoshop
b. AutoCad



c. 3D Studio Max
56.

HTML

HTML je strukturalni programski jezik koji sluzi za kreiranje dokumenta na
World Wide Web-u. Koristi se za stvaranje hipertekstualnih datoteka. HTML je
skraéenica od Hyper Text Markup Language

Notepad eventualno Notepad++. Osim Notepad-a neophodan nam je i Web
Browser. Preporucljivo je da se na kompjuteru poseduje viSe od jednog browser-
a kako bi se izgled Web stranice mogao proveriti u oba. Razli¢iti browseri
razliCito tumace pojedine HTML tagove. Ponekad su potrebne korekcije kako bi
Web stranice imale dobar izgled u razli¢itim browserima. Naravno pozeljno je i
da se poseduje i neki program za obadu grafike(Photoshop, Corel photo paint...)
kako bi se kreirale graficke datoteke koje ¢e se ugraditi u Web stranice. Doduse
na Internetu izuzetno je lako prona¢i mnogo Web grafike koja se besplatno skida
i koja se moZe ugraditi u Web stranice.

HTML se moZze nauciti pomocu tutorijala objavljenog na sajtu
http://www.w3schools.com/html

1. Microsoft Internet Explorer se koriste za:
a. Za prikaz hipertekst dokumenata
b. Za prikaz URL dokumenata
c. Za Citanje datoteka u veb formatu
d. Za prikaz hiperlinkova
e. Za prikaz datoteka u veb formatu
2. Program Firefox se koriste za:
a. Za prikaz hipertekst dokumenata
b. Za cCitanje datoteka u veb formatu
c. Zaprikaz hiperlinkova
d. Za prikaz datoteka u veb formatu
e. Za prikaz URL dokumenata
3. UHTML jeziku, set tagova i atributa je:
a. Definisan standardom
b. Definisan HTTP protokolom
c. Stvar dogovora korisnika
d. Nije definisan
e. Definisan XML jezikom
4. Veb cita¢ ima zadatak da veb serveru posalje:

a. HTTP zahtev
b. XML zahtev
c. URL zahtev
d. Trazenu HTTP datoteku
e. HTML zahtev
5. Veb sajtje:

a. Kolekcija hipertekst stranica
b. Sever na kome je publikovan sajt



c. Kolekcija URL-ova
d. Kolekcija URI-ja
e. Kolekcija hiperlinkova
PHP je skript jezik koji se koristi za:
Programiranje serverske strane
Za pisanje HTML strana
Za opis XML jezika
Za pisanje XML jezika
Kreiranje malih programskih komponenti ili kontrola unutar veb
strane
. JavaScript je jezik koji se koristi za:
a. Programiranje klijentske strane
b. Za pisanje HTML strana
c. Programiranje serverske strane
d. Za pisanje XML jezika
e. Zaopis XML jezika
Koji je jezik za opis web strane?
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a. HTML
b. Java Script
c. Paskal

. UHTML-u boje se zadaju u kom formatu?
a. Kao tri decimalna broja u zagradama (255,0,0)

b. Kao zapis u pokretnom zarezu u vrednosima od 0 do 1 (1.0, 0.5,
0.5)

c. Kao heksadecimalnom zapisu od 0 do F #FFO0AA

10. Ako boje predstavljamo u hexadecimalnom obilku onda oznaka #FFFF00

predstavlja koju boju?

a. Bela

b. Zuta

c. Zelena
d. Plava

e. Crvena

11. U HTML iskazu <h1 align="left">Naslov</h1>, ¢lan align je:
a. Atribut

b. Karakter referenca

c. Startnitag

d. Zavrs$nitag

e. Referenca

12.Jedan od sledecih tagova je karakteristican po tome S$to nema sadrzaj.

Koji?
a. p
b. br
c. align
d. center

13.Sta je HTML?

a. Hyper Text Markup Language



b. Home Tool Markup Language
c. Hyperlinks and Text Markup Language
14. Ko pravi Web standarde?
a. Netscape
b. The World Wide Web Consortium
c. Microsoft
15. Odaberite korektan HTML tag za najvece zaglavlje.

a. <head>
b. <hé6>
c. <heading>
d. <hl>
16. Sta je ispravan HTML tag za umetanja prekida linije?
a. <lb>
b. <br/>
c. <break>
17. Odaberite ispravan HTML tag da ucinite tekst podebljanim:
a. <bld>
b. <bold>
c. <b>
d. <bb>
18. Odaberite ispravan HTML tag da ucinite tekst nakoSenim (kurziv):
a. <i>
b. <italics>
c. <ii>

19. Koji je tacan HTML iskaz za kreiranje hiperlinka?
a. <aurl="http:// www.apple.com">Apple.com</a>
b. <aname="http:// www.apple.com ">Apple.com</a>
c. <a>http://www.apple.com </a>
d. <a href="http:// www.apple.com ">Apple</a>
20. Kako moZete da napravite e-mail link?
a. <mail href="xxx@yyy">
b. <mail>xxx@yyy</mail>
c. <a href="mailto:xxx@yyy">
d. <a href="xxx@yyy">
21.Kako mozete da otvorite link u novom prozoru pretrazivaca?
a. <ahref="url" new>
b. <a href="url" target="_blank">
c. <ahref="url" target="new">
22.Koji od ovih HTML tagova se odnose na tabele?
a. <table><head><tfoot>
b. <table><tr><tt>
c. <thead><body><tr>
d. <table><tr><td>
23.Kako mozete da napravite listu koja nabraja stavke sa brojevima?

a. <dl>
b. <ul>
c. <list>
d. <ol>



24.Kako mozete da napravite listu koja nabraja stavke sa znacima za
nabrajanje (crtica, tacka i drugo)?

a. <list>
b. <ul>
c. <dI>
d. <ol>

25. Sta je ispravan HTML za pravljenje ¢ekboksa?
a. <inputtype="checkbox">
b. <input type="check">
c. <check>
d. <checkbox>
26.Koja je korektna HTML sintaksa za kreiranje polja za unos teksta?
a. <textfield>
b. <input type="textfield">
c. <inputtype="text">
d. <textinput type="text">
27.Sta je ispravni HTML za pravljenje drop-down liste?
a. <input type="list">
b. <select>
c. <list>
d. <inputtype="dropdown">
28. Sta je ispravan HTML za umetanje slike?
a. <img src="image.gif"/>
b. <img href="image.gif"/>
c. <img>image.gif</img>
d. <image src="image.gif">
29.Koji HTML tag (u okviru <>) korisnik ne vidi, a sadrzi informacije o Web
strani ili sajtu?

a. span
b. keywords
c. meta
d. body

30. Koju ulogu u tagu <img src="lopta.gif" alt="Lopta"/>, ima alt atribut?
a. Prikazuje tekst "Lopta" ukoliko ucitavana slika lopta.gif ne moze da
se prikaze
Predstavlja vezu sa slikom Lopta
c. Daje alternativni fajl u slucaju da je prvi oStecen
d. Daje alternativni fajl u slucaju da .gif fajlove pretrazivac ne moze
da preuzme
31.Koja je sintaksa za HTML tagove?
a. name="value"
b. <html>
c. ${html}
d. <%html%>
32.Sta je ispravna sintaksa za umetanje horizontalne linije?
a. <line/>
b. <tr>
c. <line horizontal="true">
d. <hr/>



33. Kako definiSete stil fonta teksta?
a. <textstyle="Arial">
b. <font style="Arial"></font>
c. <style="Arial">
d. <text=Arial>
34. Gde su smesSteni tagovi i tekst koji se ne prikazuje direktno na strani?

a. title
b. body
c. tables
d. head
35. Pored taga <b>, drugi nacin da se napravi tekst bold je?
a. <fat>
b. <dark>
C. <strong>
d. <emp>
36. Koji tag se koristi za umetanje slika u veb stranice?
a. img
b. image
C. pic
d. scr

37.Da bi dodali redove u vasoj tabeli koje tagove koristite?
a. <th>..</th>
b. <br/>
c. <td>..</td>
d. <tr>..</tr>
38. Koji atribut specificira gde da posaljete formu?

a. method
b. output
c. action
d. input
39. Sta je ispravni XHTML za paragraf?
a. <p></p>
b. </p><p>
c. <P></P>
d. <P></p>

40.Koji HTML kod je "dobro-formatiran"?

<p>A <b><i>short</i></b> paragraph
NiSta od navedenog

<p>A <b><i>short</i></b> paragraph</p>
<p>A <b><i>short</b></i> paragraph</p>
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CSS

CSS je skracenica za Cascading Style Sheets. Naziv kaskadni dolazi od Cinjenice
da izmena nekog elementa HTML strane automatski sa sobom povlaci istu
izmenu na svim pod elementima tog elementa. Na primer ako postavimo da
paragraf (tag <P>) ima neki stil, recimo font teget boje, onda ¢e i svi elementi koji



se nalaze u tom tagu imati istu vrednost, recimo stavimo deo teksta u okviru
paragrafa u bold (<B>) on Ce i dalje biti teget boje.

Glavna prednost upotrebe CSS-a je u moguc¢nosti centralizovanog pristupa
izgledu sajta. Ako se radi na iole ve¢em sajtu onda je neophodno imati
centralizovano upravljanje izgledom sajta. Na primer imamo sajt sa preko 100
strana (ne tako redak slucaj u praksi) i Zelimo da promenimo bojevnu Semu na
sajtu. Recimo da sa nijansa zelene predemo na nijanse smede. Dakle, potrebno je
svakoj pozadini i svakom tekstu da se promeni boja. Ovo je ogroman posao ako
bi morali da otvaramo svaku HTML stranu posebno i da trazimo boje i menjamo
ih. Sa druge strane ako imamo jedan fajl u kome se nalaze sva podeSavanja boje
na sajtu onda moZemo samo da izmenimo u tom jednom fajlu svaku boju i time
izmenimo kompletan sajt ma koliko stranica imao.

Osim znacajne pomoci u centralizaciji vizuelane prezentacije sajta CSS ima jo$
jedan znacajan doprinos izgledu HTML prezentacije. Naime, pomoc¢u CSS-a
moZemo da unesemo dodatna podeSavanja pomocu kojih je moguce veoma
precizno pozicionirati neki element i podesiti njegove parametre. Mnogo
detaljnije i preciznije nego Sto je to moguce sa HTML-om. Zahvaljujuci CSS-u
moguce je napraviti graficki veoma bogate sajtove jer je uz pomoc¢ CSS-a moguce
precizno pozicionirati sve elemente sajta.

CSS se moze nauciti pomocu tutorijala objavljenog na sajtu
http://www.w3schools.com/css

1. Skracenisa CSS predstavlja?
a. Counter Strike Session
b. Computer System Session
c. Cascading Style Sheets
d. Computer Style Session
2. Staje ispravan HTML za upudéivanje na eksterni style sheet?
a. <link rel="stylesheet" type="text/css" href="mystyle.css">
b. <style src="mystyle.css">
c. <stylesheet>mystyle.css</stylesheet>
3. Gde u HTML dokumentu je preporuceno mesto da se uputi na eksterni
style sheet?
a. Navrhu dokumenta
b. Na kraju dokumenta
c. U <body> sekciji
d. U <head> sekciji
4. Koji HTML tag (kontrolni kod) se koristi da definiSe interni style sheet?

a. <css>
b. <script>
c. <style>
5. Koji HTML atribut se koristi da definiSe inline stilove?
a. class
b. font
c. style
d. styles

6. Koja CSS sintaksa je ispravna?
a. {body:color=black(body}
b. body {color: black}



c. body:color=black
d. {body;color:black}
7. Kako umecete komentar u CSS fajl?
a. 'ovo je komentar
b. // ovo je komentar
c. //ovo je komentar //
d. /*ovo je komentar */
8. Koje svojstvo (osobina) se koristi za promenu boje pozadine u CSS-u?
a. bgcolor:
b. color:
c. background-color:
9. Kako dodajete boju pozadine za sve <h1> elemente?
a. all.h1 { background-color: white }
b. h1 { background-color: white }
c. h1:all { background-color: white }
10. Kako se menja boja teksta elementa u CSS-u?

a. color:
b. text-color=
c. fgcolor:

d. text-color:
11. Koja CSS osobina kontroliSe velic¢inu teksta?
a. font-style
b. text-style
c. font-size
d. text-size
12. Sta je ispravna CSS sintaksa za pravljenje svih <p> elemenata bold?
a. <p style="font-size:bold">
b. <p style="text-size:bold">
c. p{font-weight:bold }
d. p {text-size:bold }
13. Kako da prikaZete hipelinkove bez podvlacenja?
a. a({text-decoration:none }
b. a{text-decoration:no underline }
c. a{underline:none }
d. a{decoration:no underline }
14. Kako se menja font elementa u CSS-u?
a. font=
b. f:
c. font-family:
15. Kako pravite tekst boldiranim?
a. style:bold
b. font-weight:bold
c. font:b
16. Kako se menja leva margina elementa u CSS-u?
a. margin-left:
b. text-indent:
c. indent:
d. margin:
17. Kako pravite listu koja lista sve stavke sa kvadratima?



type: 2
type: square
list-type: square
list-style-type: square
18. CSS moZe biti definisan za Citave sajtove jednostavnim pisanjem CSS
definicije gde?
a. Body sekcija svake strane
b. Head sekcija svake strane
c. CSS dokumenta
d. NiSta od navedenog
19. Sta od sledeceg NIJE vaze¢i CSS selektor?
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a. H1-H3{..}
b. A:hover{...}
c. H1+H3{..}
d. A#id{..}
20.U CSS-u, osobina font-style moZe da napravi tekst?
a. Vecim
b. Razli¢itih boja
c. lItalic

d. Sve navedeno
21. Na koliko nacina se mogu ukljuciti stilovi u HTML stranicu?
a. 2 - Unutar style elementa i eksternom fajlu
b. 3-Usamom tagu, unutar style elementa i eksternim fajlom
c. 4 -Usamom tagu, unutar style elementa, eksternim fajlom i kroz
meta tag
d. Stilovi se ne definiSu u HTML-u nego u CSS-u
22. Sta definiSe selektor stila?
a. Sakojim HTML elementima treba upariti pravilo
b. Veliinu prozora pretraZzivaca
c. Akciju koju treba izvrsiti prilikom prikaza
d. NiSta od navedenog

JS

Osnovni problem rada sa HTML-om je ne mogu¢nost interakcije sa korisnikom.
HTML strane su stati¢ne i nemaju interakciju. Ovo je veliki nedostatak
standardnih HTML strana. JavaScript je standardizovan programski jezik koji se
koristi u Browser-ima. Ovaj programski jezik nadomesScuje nedostatke
standardnog HTML-a obezbedujuci elementarnu interakciju sa korisnikom. Ovaj
programski jezik je modularnog tipa pa samim tim nije za komplikovanije
zadatke. Iako JavaScript ima svoje objekte ovo nije objektni programski jezik.
Ovaj programski jezik je takode i interpreterski Sto znaci da njegov kod browser
interpretira dok se stranica prikazuje. Odnosno ne kompajlira se ve¢ se sam kod
nalazi u tekstualnom obliku kad dode do korisnika pa se implementira od strane
Browsera u tom trenutku.

Trebalo bi programiranje u ovom programskom jeziku ograniciti samo na one
oblasti za koje je ovaj jezik namenjen a to je dinamicka izmena teksta, reagovanje
na dogadaje korisnika, validacija formi, kreiranje vizuelno atraktivnih



dinamickih efekata, a moZe da se korisit i za specifi¢ne situacije kada je potrbno
da se pristupi odredenim mogu¢nostima koje ima samo pojedinacni Browser.
Onda mozZe pomocu ovog programskog jezika da se napravi dvostruka
funkcionalnost kad je jedan Browser da se izvrSava jedan kod a kad je drugi,
drugi kod.
Koristi se za:

+ dinamicku izmenu teksta

» reagovanje na dogadaje korisnika

+ validaciju formi na klijentskoj strani

+ dinamicke vizuelne efekte

» detekciju korisnikovog Browser-a
JS jezik se moZe nauciti pomocu tutorijala objavljenog na sajtu
http://www.w3schools.com/js

23.Unutar kog HTML elementa se stavlja JavaScript?
a. <javascript>
b. <script>
c. <js>
d. <scripting>
24. Sta je ispravna JavaScript syntaksa za ispisivanje poruke "Hello, World!"
unutar stranice?
a. response.write("Hello, World!");
b. $("Hello, World!");
c. window.open("Hello, World!");
d. document.write("Hello, World!");
25. Gde se u okviru HTML strane moZe staviti JavaScript?
a. <head> sekcija
b. iu okviru <head> sekcije i u okviru <body> sekcije
c. <body> sekcija
26. Sta je ispravna sintaksa da se uputi na spoljasnji skript koji se zove
"external.js"?
a. <script name="external.js">
b. <script href="external.js">
c. <scriptsrc="external.js">
27.Spoljasnji JavaScript mora da sadrZi <script> tag?
a. Treba, ali nije obavezno
b. Da, mora da sadrzi HTML elemente
c. Ne sme da sadrZi <script> tag jer nije HTML
28. Kako pisSete "Hello World" u boksu upozorenja?
a. message("Hello World")
b. alertBox="Hello World"
c. alert("Hello World")
d. alertBox("Hello World")
29. Kako se kreira funkcija u JavaScript-u?
a. function=myFunction()
b. function myFunction()
c. function:myFunction()
30. Kako pozivate funkciju sa imenom "myFunction" u JavaScript-u?
a. call myFunction()



b. call function myFunction
c. myFunction()
31. Kako piSete uslovni iskaz za izvrSavanje nekih iskaza samo ako je "i"

jednako 57
a. ifi=5 then
b. if (i==5)
c. ifi==5then
d. ifi=5
32.Kako piSete uslovni iskaz za izvrSavanje nekih iskaza samo ako je "i" NIJE
jednako 57
a. if(i!=5)
b. if (i <>5)
c. if=!5then
d. if<>5

33. Koliko razlicitih vrsta petlji postoji u JavaScript-u?
a. Dve - "for" petlja i "while" petlja
b. Pet- "for", "while" "do...while", "loop...until" i "goto" petlja
c. Tri-"for" petljaidve "while" petlje
34.Koje je ispravno zaglavlje "for" petlje
a. for (i<=5;i++)
b. fori=1to5
c. for(i=0;i<=5;i++)
d. for(i=0;i<=5)
35. Kako se piSu komentari u JavaScriptu?
a. <!--Ovo je komentar -->
b. // Ovo je komentar
c. ;Ovo je komentar (iza tacka-zareza)
36.Koja je ispravna sintaksa JavaScripta za umetanje komentara duZih od
jedne linije?
a. /*Ovaj komentar ima viSe od jedne linije */
b. // Ovaj komentar ima viSe od jedne linije //
c. <!-- Ovaj komentar ima viSe od jedne linije -->
37.1zaberite ispravan kod za inicijalizaciju nizova u JavaScript-u?

a. var txt = new Array = "tim", "kim", "jim"
b. var txt = new Array("tim", "kim", "jim")
c. var txt=new Array: 1=("tim") 2=("kim" )3=("jim")
d. var txt = new Array(1:"tim", 2:"kim", 3:"jim")
38.Koja su, od navedenih, ispravna imena promenljivih u JavaScript jeziku?
a. Default
b. firstText

c. _first Text

d. 1stText
39. Obicno je preporucljivo Cuvati Sto je moguce viSe JavaScript koda u kojoj
sekciji?
a. Layer
b. Title
c. Head
d. Body

40. JavaScript linije se zavrSavaju sa ¢im?



a. zarezom
b. tackom izarezom
c. dve tacke
d. zagradom

41. Najces¢i nacin da dodelimo vrednost promenljivoj je koriS¢enjem cega?
a. Znaka jednakosti

b. HTML
¢. Njenim imenovanjem
d. CSS
42.a++; ima isto znacenje kao koja od sledecih naredbi:
a. a+=1;
b. a=+1;
C. C++
d a=1;
43. Kada uporedujete promenljive po jednakosti, Sta koristite od sledeceg?
a. =
b. I=
c. 7
d. ==

44. Da se kod ne bi izvrSio odmah po ucitavanju stranice, moZemo ga
definisati kao:

a. funkciju
b. kaSnjenje
c. thread

d. fleksibilan kod
45. Akcije koje mogu biti detektovane od strane JavaScripta zovu se?

a. Dogadaji
b. HTML
c. Array (nizovi)
d. objekti
46.Da li JavaScript razlikuje mala od velikih slova u nazivima?
a. Da
b. Samo u nazivu funkcija
c. Ne
d. Samo pocetno slovo promenljive

sQL

SQL (Structured Query Language) je internacionalni standardni jezik kojeg
razumeju svi komercijalni sistemi za upravljanje bazama podataka. SQL je
strukturalni jezik ¢ije naredbe se prosleduju do DBMS (data base management
system) gde se obraduju i izvrSavaju. Rezultati rada DBMS-a se prosleduju kao
rezultat rada SQL upita. Oni su takode u obliku SQL jezika.

Prvi komercijalni RDBMS koji je koristio SQL je napravila korporacija Oracle.
Mada su originalne verzije razvijane za VAX/VMS sisteme Oracle su bili jedni od
prvih proizvodaca koji su napravili DOS verziju RDBMS-a (Oracle je sada
prisutan na skoro 70 platformi). Sredinom osamdesetih Sybase je napravio
RDBMS SQL server. Sa bibliotekama klijenata za pristup bazama podataka,
podrskom za zapisane procedure i mogu¢noscu rada sa razli€itim mreZama, SQL



Server je postao uspesan proizvod narocito u klijent/server okruzZenju. Jedna od
najjacih tacaka oba snaZzna SQL Server sistema bila je pokretljivost kroz
platforme. Kod u jeziku C (u kombinaciji sa SQL-om) pisan za Oracle na PC-u je
virtuelno identi¢an kodu pisanom za Oracle bazu podataka koja se izvrSava na
VAX sistemu.

SQL je implementiran u viSe od 50 komercijalno raspoloZzivih sistema za
upravljanje bazama podataka (SUBP-ova) relacionog tipa (DB2, SQL/DS,
ORACLE, ...). Znaju¢i SQL moguce je na gotovo identi¢an nacin raditi sa bilo kojim
od njih. Proizvodaci relacionih RDBMS sa drugim upitnim jezicima prinudeni su
da omoguce alternativno koriS¢enje i SQL-a, kako bi opstali na trzistu.

SQL je jezik koji je okrenut korisniku. U¢i se lako i brzo, a prethodno iskustvo u
automatskoj obradi nije neophodno.

SQL jezik se moZe nauciti pomocu tutorijala objavljenog na sajtu
http://www.w3schools.com/sql

1. Structured Query Language (SQL) je:
a. internacionalni standardni jezik kojeg razumeju svi komercijalni
sistemi za upravljanje baza podataka
b. veliki i komplikovan sistem za upravljanje bazom podataka,
licenciran od strane proizvodjaca kao Sto su Microsoft, Oracle i
IBM
c. racunarski program sa kojima korisnici imaju direknu interakciju
2. Kojaje SQL komanda za uzimanje podataka iz baze podataka?

a. SELECT
b. EXTRACT
c. GET
d. OPEN
3. Kojaje SQL komanda za izmenu podataka u bazi podataka?
a. SAVE
b. MODIFY
c. UPDATE
d. SAVE AS
4. Kojaje SQL komanda za brisanje podataka iz baze podataka?
a. REMOVE
b. DESTROY
c. DELETE
d. COLLAPSE

5. Kojaje SQL komanda za dodavanje podataka u bazi podataka?
a. INSERTINTO

b. UPDATE
c. ADD
d. CREATE

6. Kako ¢ete SQL komandom prikazati sve kolone tabele "Osobe"
a. SELECT [all]] FROM Osobe
b. SELECT * FROM Osobe
c. SELECT Osobe
d. SELECT *.Osobe
7. Kako ¢ete SQL SELECT komandom prikazati sve kolone tabele Person kod
kojih ime pocinje sa slovom 'a' a zavrSava slovom 'b’



10.

11.

12.

13.

14.

15.

a. SELECT * FROM Persons WHERE FirstName LIKE 'a%b%'
b. SELECT * FROM Persons WHERE FirstName="'a%b'
c. SELECT * FROM Persons WHERE FirstName LIKE 'a%b'
d. SELECT * FROM Persons WHERE FirstName="'a%b%'
U SQL upitu OR operator prikazuje sve zapise kod kojih bilo koji uslov
ispunjen a AND operator prikazuje zapise kod kojih su svi uslovi ispunjeni
a. Netacno
b. Tacno
Kojom od niZe navedenih SQL komandi ¢ete prikazati sve slogove iz
tabele Person kod kojih je FirstName Petar ili Milan
a. SELECT FirstName="'Petar’, LastName='Milan' FROM Persons
b. SELECT * FROM Persons WHERE FirstName="'Petar' OR
FirstName="'Milan'
c. SELECT * FROM Persons WHERE FirstName LIKE 'Petar' AND
LastName LIKE 'Milan'

Koja je kljucna rec¢ za prikaz samo slogova koji su razliCitih vrednosti
a. UNIQUE
b. DISTINCT

c. DIFFERENT
Kako se u MySQL-u u sql naredbi za kreiranje tabele definiSe podatak kao
primarni kljuc koji se sam inkrementira?

a. IDint NOT_NULL AUTO_INCREMENT, PRIMARY_KEY(ID),

b. ID int PRIMARY KEY(ID),

c. ID int PRIMARY_KEY(ID),

d. ID int NOT NULL AUTO_INCREMENT, PRIMARY KEY(ID),
Kako se u MySQL-u u sql naredbi za kreiranje tabele definiSe da je neki
podatak obavezno uneti?

a. FirstName varchar(15) NOT_NULL,

b. FirstName varchar(15) MANDATORY,

c. FirstName varchar(15) PRIMARY,

d. FirstName varchar(15) NOT NULL,
Kako glasi sql naredba (odnosi se na MySQL) kojom se iz table PERSON
uzimaju sve osobe koje se prezivaju Petrovic?
"SELECT * FROM person WHERE LastName="'Petrovic"
"SELECT * FROM person WHERE 'Petrovic'
"SELECT * FROM person WHERE LastName ARE 'Petrovic'
"SELECT * FROM person" a onda se u php-u iz rezultat uzimaju
samo oni kojima je prezime Petrovic
Da li je moguce podatke iz baze dobiti sortirane po nekom parametru?

a. Dapomocu sql upita "SELECT * FROM person ORDER age"

b. Nije moguce dobiti sortirano iz baze, sortiranje je moguce izvrSiti u

PHP-u.

c. Dapomocu sql upita "SELECT * FROM person SORT BY age"

d. Dapomocu sql upita "SELECT * FROM person ORDER BY age"
Sta radi slede¢i sql upit? "UPDATE Person SET Age = '36™"

a. Menja svim podacima u tabeli kolonu Age na vrednost 36

b. Daje poruku o gresci da nije specificiran red na koji se odnosi

c. Menja samo prvom redu u tabeli kolonu Age na vrednost 36

a0 o



d. Menja poslednjem unetom redu u tabeli kolonu Age na vrednost
36
16. Sta radi slede¢i sql upit? "DELETE FROM Person"
a. BriSe sve unete podatke iz tabele Person
b. Daje poruku o gresci da nije specificiran red na koji se odnosi
c. BriSe poslednji unet red iz tabele Person
d. BriSe prvired iz tabele Person

PHP

PHP (Hypertext Preprocessor) je skripting jezik za programiranje serverske
strane web sistema. PHP skripte se izvrSavaju na strani servera pre nego Sto se
strana uputi ka klijentu. On je opensource proizvod, Sto znaci da je besplatan i
dostupan svima za koriS¢enje i usavrsvanje. PHP omogucuje pristup bazama
podatka i radi sa svim poznatim bazama podatka pomoc¢u stnadardizovanog
jezika za pristup bazama podatka SQL.

PHP programski jezik se moZe naucit pomocu tutorijala objavljenog na sajtu
http://www.w3schools.com/php

1. Sta oznacava skraéenica PHP?
a. Personal Hypertext Processor
b. Private Home Page
c. PHP: Hypertext Preprocessor
d. Personal Home Page
2. PHP server skriptovi su okruZeni sa ogranivacima, kojim?
a. <?php>..</?>
b. <script>..</script>
c. <?php..7?>
d. <&>..</&>
3. Kako pisSete "Hello World" u PHP-u?
a. "Hello World";
b. echo "Hello World";
c. Document.Write("Hello World");
d. niSta od navedenog
4. Sve promenljive u PHP-u pocinju sa kojim simbolom?

a. $
b. !
c. nista od navedenog
d &
5. Staje ispravan nacin da se zavr$i PHP iskaz?
a. ;
b. .
c. Newline
d. </php>
6. PHP sintaksa je najsli¢nija sa:
a. VBScript
b. PerlandC

c. nista od navedenog



d. JavaScript
7. Kako dobijate informacije iz forme koja je predata koriS¢enjem "get
metoda?
a. $_GET[];
b. Request.QueryString;
c. nista od navedenog
d. Request.Form;
8. Kada koristite POST metod, promenljive su prikazane u URL-u:
a. Mogu da budu, ali ne moraju
b. Tacno
c. Netacno
9. Kada koristite GET metod, promenljive su prikazane u URL-u:
a. Mogu da budu, ali ne moraju
b. Netacno
c. Tacno
10. U PHP-u mozete da koristite i jednostruke navodnike ('') i dvostruke
navodnike (" ") za stringove:
a. Netacno
b. Tacno
c. Zavisi od situacije
11. Sta je ispravan nacin da kreirate funkciju u PHP-u?
a. function myFunction()
b. niSta od navedenog
c. create myFunction()
d. new_function myFunction()
12. Sta je ispravan nacin da dodate 1 promenljivoj $count?
a. $count++;
b. ++count
c. $count=+1
d. count++;
13. Sta je ispravan nacin da dodate komentar u PHP?

a. [*.*/
b. *\.\*
c. <comment>...</comment>
d. <l-..-->
14. Koja od ovih promenljivih ima nepravilno ime?
a. $my-Var
b. $my_Var
c. $myVar

d. niSta od navedenog
15. Koja od ovih promenljivih ima pravilno ime?

a. $my Var
b. $my-Var
c. $myVar

d. sve navedene
16. Kako se definiSe funkcija u PHP-u?
a. new moja_funkcija() { echo 'Ovo je funkcija’; }
b. moja_funkcija() { echo 'Ovo je funkcija'; }
c. function moja_funkcija() { echo 'Ovo je funkcija’; }



d. new_function moja_funkcija() { echo 'Ovo je funkcija'; }
17. Koje od navedenih moZze da se koristi kao naziv funkcije?

a. pdv procenat()

b. pdvProcenat()

c. Spdv()
d. pdv%()
18. Koje od navedenih ne moZe da se koristi kao naziv funkcije?
a. ZaSlanje()
b. za_slanje()
c. 4slanje()
d. zaslanje()
e. zaSlanje()

19. Ako definiSemo niz:
20. $mojNiz = array(‘prvi’,'drugi’, treci’);
21. onda moZemo ovaj niz proslediti funkciji koja prima nizove na sledeci

nacin?
a. mojaFunkcija($mojNiz);
b. mojaFunkcija($mojNiz[0], $mojNiz[1], ...);
c. mojaFunkcija(mojNiz);
d. mojaFunkcija(mojNiz[]);

®

mojaFunkcija($mojNiz[]);
22.Kako se deklrise funkcija kojoj se parametar prosleduje po vrednosti?
a. function mojaFunkcija($value)
b. function mojaFunkcija(&value)
c. function mojaFunkcija(value)
d. function mojaFunkcija(&$value)
23.Kako se ustanovljava da li neka promenljiva ima vrednost?
a. if($promenljiva){... }
b. if(isset($promenljiva)){.. }
c. if($promenljiva ==null) {... }
d. if(is $promenljiva != null){ ... }
24. Ako se instancira klasa Osoba promenljivom osob kako se poziva njen
atribut ime?
a. 0sob ->ime;
b. $osob -> $ime;
c. osob -> $ime;
d. $osob ->ime;
25. Kako se instancira klasa Osoba?
a. $osob =new Osoba();
b. Osoba -> $osob;
c. $osob = Osoba();
d. Osoba $osob = new Osoba();
26.Kako se u PHP-u deklariSe klasa MojaKlasa koja nasleduje klasu
DrugaKlasa?
class MojaKlasa inherite DrugaKlasa
class MojaKlasa implements DrugaKlasa
class MojaKlasa inherit DrugaKlasa
class MojaKlasa extends DrugaKlasa
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27. Ako postoji klasa A sa private metodom mojaMetoda() i kreira se klasa B
koja nasleduje klasu A. Kako pristupamo metodi mojaMetoda() iz instance
klase B $bInstanc?

a. Nije moguce pristupiti metodi mojaMetoda().

b. $blnstanc.A->mojaMetoda();

c. $binstanc.mojaMetoda();

d. $binstanc->mojaMetoda();
28.Kaoji je pravilan pocetak kreiranja forme u PHP-u?

a. <form>

b. <form action="Welcome.php" method="post">

c. <form method="“post“>

d. <form action="mailto:mateja@fit.edu.rs" method="“post“ >
29.Kako se u PHP-u definiSe text polje?

a. <input type="textfield" name="username" value="" size="20" />

b. <input type="string" name="username" value="" size="20" />

c. <inputtype="inputfield" name="username" value="" size="20" />

d. <inputtype="text" name="username" value="" size="20" />

30. Kako se u PHP-u definiSe tekstualno polje kod koga ne moZe da se vidi Sta
korisnik unosi (kao prilikom unosa lozinke)?

a. <input type="text" hidden = true name="lozinka" value=
size="20" /> <input type="hidden" name="lozinka" value=

size="20" />
b. <input type="passwordfield" name="lozinka" value="" size="20"
/>

c. <inputtype="password" name="lozinka" value="" size="20" />
31. Ako je sa neke forme na stranu poslat post metodom parametar ,ime“ sa
svojom vredno$¢u on moze da se prikaze na sledec¢i nacin?
a. <?php echo $_POST["ime"]; 7>
b. <?php echo $_POST.$ime; 7>
c. <?php echo $ime; 7>
d. <?php echo $_POST->ime; ?>
32.Dali je moguce pokupiti podatak ,ime“ na PHP strani ako neznamo kojom
metodom sa forme je poslat?
a. Dapomocu $_REQUEST["ime"]
b. Dapomocu $_GET&_POST["ime"
c. Nije moguce
d. Dapomocu $_GET["ime"]
33.Kako se odreduje veliCina poslatog (uploadovoanog) fajla myfile u
kilobajtima?
a. $_REQUEST["myfile"]["size"] / 1024
b. $_POST["myfile"]["length"] / 1024
c. $_FILES["myfile"]["vel"] / 1024
d. $_FILES["myfile"]["size"] / 1024
34. Kako se ustanovljava naziv poslatog (uploadovoanog) fajla myfile?
$_REQUEST["myfile"]["temp_name"]
$_POST["myfile"]["'name"
$_REQUEST["myfile"]["'name"]
$_POST["myfile"]["temp_name"]
$_FILES["myfile"]["temp_name"]
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f.  $_FILES["myfile"]["'name"
35. Kako moze da se ustanovi da li je bilo greSke prilikom slanja (upload-a)
fajla myfile?
a. if ($_FILES["myfile"]["error"] > 0)
b. if ($_FILES["myfile"] != null)
c. if ($_REQUEST["myfile"] != null)
d. if ($_REQUEST["myfile"]["error"] > 0)
36. Kako se ustanovljava da li cookie postoji na racunaru klijenta?
a. if (isset($_COOKIE["user"]))
b. if (isset($_COOKIE))
c. if ($_COOKIE !=null)
d. if ($_COOKIE["user"] !=null)
37.Kako se briSe cookie?
a. $ COOKIE = null
b. $_COOKIE["user"] = null
c. setcookie("user","", time()-3600);
d. deletcookie("user");
38. Kako se startuje sesija u PHP-u?
a. <?php session(); 7>
b. <?php session_start(); 7>
c. Sesija se automatksi startuje ¢im korisnik pristupi prvoj strani
d. <?php session_load(); 7>
39. Sa kojim bazama podatak moZe da se poveze PHP?
a. PHP ne moZe da radi sa bazama podataka.
b. Sasvim SQL bazama podataka.
c. Samo sa MySQL bazom podataka.
d. Samo sa Oracle bazama podataka.
40. Sta znadi skrac¢enica SQL?
a. Structured Query Language
b. Sequence Query Language
c. Sequence Queue Location
41. Kako se uspostavlja konekcija sa MySQLbazom podataka?
a. $con = mysql_connect("localhost","korisnik","sifra123");
b. $con = connect("localhost”,"korisnik","sifra123");
c. $con = mysql_con("localhost","korisnik","sifra123");
d. $con = mysql("localhost","korisnik","sifra123");
42. Ako nije uspela konekcija na MySQL bazu podataka kako saznajemo
poruke o gresci?
a. mysql_message()

b. error()
c. Nije moguce saznati zbog cega konekcija nije uspostavljena
d. mysql()

e. mysql_error()
43. Konkekcija sa MySQL bazom se zavrSava na koji od slede¢ih nacina?
a. Pozivom naredbe close($con);
b. Konekcija se zavrsava iskljuc¢ivo automatski kada se korisnik
izloguje Pozivom naredbe mysql_close($con);
c. Konekcija se zavrsava isklju¢ivo nakon 30 min ne aktivnosti.
44.Da li je moguce kreiranje MySQL baze podataka iz PHP-a?



a. Da php naredbom mysql_create(,mydb*);

b. Daslanjem SQL upita ,CREATE DATABASE mydb*“

c. Nije moguce kreirati bazu iz PHP-a, moguce raditi samo sa ve¢
kreiranim bazama.

45. Kako glasi PHP naredba za kreiranje tabele u bazi podataka?

a. mysql_create_table(,MojaTabela“);

b. Ne postoji PHP naredba za kreiranje tabele ve¢, se bazi Salje SQL
naredba za kreiranje tabele pomoc¢u php-ove naredbe
mysql_query.

c. mysql_table(,MojaTabela“);

d. mysql_create(,MojaTabela“ ,Table“);

46. Pomocu koje PHP-ove naredbe selektujemo bazu kojoj Saljemo upit?

a. Baza se Salje kao parametar mysql_query($sql, $"my_db", $con);

b. mysql_select("my_db", $con);

c. mysql_db("my_db", $con);

d. mysql_select_db("my_db", $con);

47.Kada je rezultat rada sql upita tabela podataka onda iz toga moZemo uzeti
pojedinacni red pomoc¢u koje PHP-ove naredbe?

a. $row = mysql_array($result);

b. $row = mysql_result($result);

c. $row = mysql_fetch_array($result);

d. $row = mysql_fetch($result);

48. Kada se odabere jedan red ($row) iz tabele koju je vratio sql upit onda
pojedinacan podatak iz tog reda se uzima na koji nacin?

a. $row.get('FirstName')

b. $row.FirstName

c. $row->FirstName

d. $row]['FirstName']

49. Konekcija na ne druge baze (koje nisu MySQL) se postizZe pomocu koje
naredbe?

a. mysql_connect

b. odbc_connect

c. connect

d. Iz PHP-a nije moguc¢ rad sa drugim bazama podataka
e. db_connect

Opsta racunarska pitanja

1. Koji od navedenih proizvodaca viSe ne proizvodi laptop racunare?

a. Apple
b. HP

c. IBM

d. Lenovo

2. Kuciste na koje se drzi monitor spada u tip?

a. Minitower



b. Tower

c. Desktop
Peer-to-peer mreZa je mreza?

a. MreZa za razmenu nedozvoljenog sadrzaja

b. MreZa ravonopravnih korisnika

c. Zasti¢ena mreZa za razmenu poslovnog sadrzaja
Pod domen org je rezervisan za?

a. Obrazovne institucije

b. Ne profitabilne organizacije

c. Korporaacije

d. Vladine institucije
Jedan inc je pribliZno:

a. 25,4mm
b. 31,2mm
c. 18.7mm
d. 21.2mm

Deo tastature koji se nalazi sa krajnje desne strane tastature i koji sluZzi za
unos brojeva i osnovnih aritmetickih operacija zove se:

a. Funkcijski deo tastaure
b. Numercki deo tastature

c. Alfanumericki deo tastature
Sta oznacava skracenica XML?

a. Extensible Markup Language
b. Extreme Mother Language

c. Extendable Main Language
Sta oznacava pojam Virtuelizacija?

ProSirivanje fizicke memorije upotrebom hard diska.
b. Pokretanje viSe aplikacija na istom operativnom sistemu.

c. Pokretanje viSe operativnih sistema paralelno na istom fizickom
racunaru.



